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Clear-Com

End User Software License

IMPORTANT:  CAREFULLY READ THE FOLLOWING BEFORE 
USING THIS SOFTWARE.  USING THE SOFTWARE INDICATES 
YOUR ACKNOWLEDGMENT THAT YOU HAVE READ THE 
FOLLOWING AND AGREE TO ITS TERMS.  
IF YOU DO NOT AGREE, RETURN THE SOFTWARE COMPLETE 
TO CLEAR-COM OR YOUR CLEAR-COM REPRESENTATIVE AND 
CANCEL THE INSTALLATION.
THIS IS YOUR PROOF THAT YOU HAVE A VALID LICENSE.  
PLEASE TREAT IT AS VALUABLE PROPERTY.
HME CLEAR-COM LIMITED OR CLEAR-COM LLC., as the case 
may be (hereinafter referred to as “CLEAR-COM”), offers you this 
storage media containing a computer program and files (the 
“SOFTWARE”) and offers to grant to you a non-exclusive  and 
non-transferable License to use the Software on the following 
terms.  Any new revision or update of the Software provided by 
CLEAR-COM to Customer under this License shall be governed 
by the terms and conditions of this License.

1. APPLICATION
a. These terms supersede all prior agreements representations 

and understandings between you the Customer and Clear-Com 
and their authorised representatives relating to the subject 
matter hereof (i.e., the Software) but shall otherwise be subject 
to Clear-Com Terms and Conditions, as amended from time to 
time.  For the avoidance of doubt, in the event of conflict, these 
terms shall prevail. 

b. No variation to these terms, nor any other terms or conditions 
proposed by you, shall be of any effect unless recorded in a 
written document signed by Clear-Com. You confirm that any 
statement made to the contrary by you or on your behalf shall 
not apply to this License.

c. You confirm that you are not relying on any statement made by 
or on behalf of Clear-Com, other than statements recorded in a 
written document signed by Clear-Com.

d. Clear-Com and its licensors reserve all rights not expressly 
granted to you.  Clear-Com's licensors are intended third party 
beneficiaries of this Agreement and have the express right to 
rely upon and directly enforce the terms set forth herein.

e. You agree that the Software belongs to Clear-Com and its 
licensors.  You agree that you neither own nor hereby acquire 
any claim or right of ownership to the Software or to any related 
patents, copyrights, trademarks or other intellectual property.  
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Clear-Com and its licensors retain all right, title and interest in 
and to the Software and all copies thereof at all times, 
regardless of the form or media in or on which the original or 
other copies may subsequently exist.  This license is not a sale 
of the original or any subsequent copy.

2. COPYRIGHT
a. The copyright and all other rights in the Software produced by 

Clear-Com shall remain with Clear-Com or its suppliers.  You 
must reproduce any copyright or other notice marked on the 
Software on any copies that you make. 

3. YOU MAY: 
a. Use the Software only at a single site location.  If you wish to use 

the Software at more than one site you must contact Clear-Com 
and if required purchase further Licenses;

b. Make one copy of the Software for archival or back-up purposes, 
and;

c. Transfer the Software to an end user of a Clear-Com product, 
only if you have made it clear to Clear-Com that you are not the 
end user and you assign all of your rights under this License 
and make no use of the Software yourself. 

4. YOU MAY NOT:
a. Use the Software or make copies of it except as permitted in this 

License;
b. Publish or distribute the computer images, sound files or fonts 

included with the Software as computer images, sound files or 
fonts;

c. Translate, reverse engineer, decompile or disassemble the 
Software, except to the extent the foregoing restriction is 
expressly prohibited by applicable law;

d. Rent, lease, assign or transfer the Software except as set out 
above; or

e. Modify the Software or merge all or any part of the Software in 
another program.

5. TERM:
a. This License shall continue for as long as you use the Software.  

However, it will terminate if you fail to comply with any of its 
terms or conditions.  You agree, upon termination, to destroy all 
copies of the Software.  The Limitations of Warranties and 
Liability set out below shall continue in force even after any 
termination.

6. LIMITED WARRANTY:
a. Clear-Com warrants that the storage media in this Software will 

be free from defects in materials and workmanship for 90 days 
from the date you acquire it.  If such a defect occurs, return it to 
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us at the address below and we will replace it free.  This remedy 
is your exclusive remedy for breach of this warranty.

b. After the initial 90 days, THE SOFTWARE IS PROVIDED "AS 
IS" WITHOUT WARRANTY OF ANY KIND EITHER EXPRESS, 
IMPLIED OR STATUTORY, INCLUDING BUT NOT LIMITED 
TO THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, PERFORMANCE, 
ACCURACY, RELIABILITY, OR NON-INFRINGEMENT OF 
THIRD-PARTY INTELLECTUAL PROPERTY RIGHTS.  This 
constitutes an essential part of this License.

7. LIMITATION OF LIABILITY:
a. For the avoidance of doubt, all conditions imposed by law 

covering matters such as fitness for purpose, compliance to 
description, negligence and quality are expressly excluded from 
this agreement and you agree to accept the foregoing warranty 
in lieu of all such items. 

b. IN NO EVENT SHALL CLEAR-COM BE LIABLE FOR ANY 
LOSS OF PROFITS, LOSS OF BUSINESS, LOSS OF DATA 
OR USE OF DATA, INTERRUPTION OF BUSINESS, OR FOR 
INDIRECT, SPECIAL, INCIDENTAL, EXEMPLARY, MULTIPLE, 
PUNITIVE OR CONSEQUENTIAL DAMAGES OF ANY KIND, 
WHETHER BASED ON CONTRACT, TORT (INCLUDING 
WITHOUT LIMITATION, NEGLIGENCE), WARRANTY, 
GUARANTEE OR ANY OTHER LEGAL OR EQUITABLE 
GROUNDS, EVEN IF CLEAR-COM HAS BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES.  

c. The warranty is personal to you (or end user if you have made it 
clear that you are not the end user) and may not be transferred 
(except as permitted expressly above). 

d. Clear-Com shall not be a liable for failure to perform any 
obligation to you where such failure is due to circumstances 
beyond Clear-Com’s reasonable control.

e. Clear-Com offers extended warranties and, if you are not 
satisfied with the above, you should consider such 
warranties or consider separate insurance. 

8. RESTRICTED RIGHTS:
If this Software is acquired by or for the U.S. Government then it is pro-
vided with Restricted Rights.  Use, duplication, or disclosure by the U.S.
Government is subject to restrictions as set forth in subparagraph
(c)(1)(ii) of The Rights in Technical Data and Computer Software clause
at DFARS 252.227-7013, or subparagraphs (c)(1) and (2) of the Com-
mercial Computer Software - Restricted Rights at 48 CFR 52.227-19, or
clause 18-52.227-86(d) of the NASA Supplement to the FAR, as appli-
cable.  Contractor/manufacturer: HME Clear-Com Limited, 7400 Beach
Drive, Cambridge, England CB25 9TP or Clear-Com LLC., 850 Marina
Village Parkway, Alameda, CA 94501.
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9. OTHER ISSUES:
a. Any failure by Clear-Com to insist on its strict rights under this 

Agreement shall not be deemed to be a waiver of those (or any 
other rights) and only a duly executed written release shall 
constitute such a waiver.

b. If any of these conditions is deemed invalid or unenforceable the 
remainder shall be unaffected. 

c. Clear-Com's dealings with you shall be governed by English law 
if you are resident in the EMEA region and California law if you 
are resident elsewhere.  The federal and state courts of 
California for Non-EMEA Customers and English Courts for 
EMEA Customers shall have exclusive jurisdiction to adjudicate 
any dispute arising out of this Agreement.

d. If any document is written in more than one language the 
English text shall prevail.  

e. Capitalized terms not defined herein shall have the meanings 
set forth in Clear-Com Terms and Conditions, as amended from 
time to time.
Clear-Com
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INTRODUCTION TO 
ECS 

The Eclipse Configuration Software (ECS) provides a powerfully visual 
and intuitive way to program the Eclipse matrix system. With the 
software’s graphical views of matrices, cards and panels, the operator 
can quickly and efficiently create communication pathways between 
devices connected to the system.

This manual describes the features of ECS release V5.2.

Figure 1-1: An Eclipse Matrix System 

Specifically ECS can: 

• Create individual, point-to-point talk and listen paths between 
members of a matrix intercom system. 

• Create groups and one-to-many calls (“fixed groups”). 

• Create many-to-many conferences (“party lines”).

The Eclipse Configuration 
Software (ECS) provides a 
powerfully visual and intuitive 
way to program the Eclipse 
matrix system. 

A “configuration” or “map” 
forms a complete set of 
communication pathways 
between devices connected 
to the matrix. 
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• Store a complete system setup—called a “configuration map”— in an 
electronic file on a computer. Download the setup to the matrix to 
go into effect immediately.   

• Store four complete configuration maps in the matrix’s on-board 
memory, any of which can be activated immediately from the front 
of the matrix with the push of a button.  

• Communicate with CellCom/FreeSpeak beltpacks allowing direct 
communication between panels and roaming users.

• Communicate with remote panels over IP.

• Interface with the Clear-Com Concert™ multi-user conferencing 
system over IP.

• Interface the intercom system with telephones, two-way radios, 
camera intercoms, and more. 

• Bring an outside audio source, such as program source, into the 
system’s audio stream and interrupt the program audio for 
announcements (IFBs). 

• Use the GPIO facility to activate an applause light in a studio, a lock 
on a door, or other control functions each time an external device 
such as a switch is triggered.

• Control, monitor, or run diagnostics on a matrix system remotely from 
anywhere in the world, if the matrix  is set up on a LAN network. 

• Link matrices across cities, nations, and continents. 

• And perform many other functions. For more information on individual 
panels, interfaces, and features of the Eclipse Matrix Systems, 
refer to the complete set of manuals, which are available at 
www.clearcom.com or on the Eclipse documentation CD (part 
750017Z). 

TERMINOLOGY
Production-intercom technology has evolved over the years.  Remote 
devices connected to the matrix were first called “panels” to 
correspond to the metal  faceplates that were installed on racks. Later 
they were called “stations” when they became fully independent 
stand-alone units with metal housing covering the internal circuitry. 

Since in many parts of the world, only one or the other of these terms 
is used, this manual normally refers to these units as panels.  
However, keep in mind that the terms “station” and “panel” generally 
refer to the same type of remote intercom device. 
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ELEMENTS OF A MATRIX COMMUNICA-
TIONS SYSTEM 
A complete Eclipse communication system consists of the Eclipse 
Configuration Software (ECS) programming software, a central 
hardware matrix, intercom panels and the remote devices - interfaces, 
4-wire equipment—connected to the matrix. The following sections 
give a brief overview of the matrix system. 

CENTRAL MATRIX    
The matrix hardware assembly consists of the following components:

• The metal housing, sometimes called the “frame”

• The central processing unit (CPU)

• The internal circuitry which controls the attached devices 

• Power supplies 

• The rear panel interfaces which link the matrix to intercom panels and 
remote devices such as  interfaces 

• The rear panel interfaces which link the matrix to 
CellCom/FreeSpeak antennae

• The rear panel interfaces providing fiber-optic links between matrices

Figure 1-2: Eclipse Omega Matrix

Frame   
The matrix chassis, or “frame”, is a metal rectangular box which 
houses the matrix internal circuitry and power supplies. Some matrices 
hold removable circuit cards, while others contain fixed internal 
circuitry.   The larger matrices (Omega and Median)  have removable 
power supplies, which can be exchanged when necessary. 
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The following are the main elements of the Eclipse central matrix: 

Central Processing Unit (CPU) 
The nucleus of the matrix communication system is the central 
processing unit (CPU). It provides the serial data and Ethernet 
connection to the connected PC computer. The CPU also coordinates 
the data flow for other features of the system, such as general-purpose 
outputs and inputs. The CPU stores four complete system 
configurations in its memory, which can be retrieved and activated 
directly from the matrix’s front-panel controls, even when the matrix is 
not connected to a computer. 

Each matrix system contains at least one central processing unit, 
located either on its own removable circuit card, or in internal circuitry. 
Some matrices, such as the Eclipse Omega, contain a backup CPU for 
fail-safe operation. 

Internal Circuitry   
The matrix’s internal circuitry controls the operation of the panels and 
interfaces connected to it. Panels and interfaces connect to the 
matrix’s internal circuitry through an RJ-45 connector, or “port”, on the 
matrix’s rear panel. The internal circuitry sends balanced duplex audio 
and RS-422 data signals to and from connected audio equipment 
through 4-pair shielded category-5 (CAT-5) cable (STP). 

Each audio device connected to the matrix can communicate with all 
other audio devices in the system. For intelligent linking, shielded 
category-5 cable is run from a port on one Eclipse matrix to a port on a 
second Eclipse matrix to form a trunkline connection.

The Eclipse Omega and Median matrix internal circuitry can also 
control fiber optic interfaces to provide high-speed links between 
matrices and E1 interfaces to allow communication with wireless 
system antennae.

Power Supplies 
Each Eclipse Omega or Median matrix can hold two independent 
power supplies.  These may be connected to a main and backup 
power source for redundancy.   In the event of failure of one of these 
power supplies, the second supply automatically takes over. 

In the event of a complete power failure, a matrix can automatically 
restore itself to complete functioning by retrieving configuration 
information from its non-volatile operational memory.

The Eclipse Pico and Eclipse-32 matrices have a dual AC input power 
supply unit.
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Rear-Panel Connectors 
A matrix connects to remote devices such as intercom panels, 
interfaces, general purpose inputs and outputs, local area networks, a 
computer, and other matrices through its rear-panel connectors.  

The rear-panel RJ-45 sockets, sometimes called “ports”, connect the 
matrix to intercom panels, beltpack antennas, Concert servers, other 
matrices and interfaces with shielded category 5 (CAT-5) cable.

ECLIPSE CONFIGURATION SOFTWARE (ECS) 
The Eclipse Configuration Software (ECS) controls the operation of the 
system’s connected audio devices via a system map downloaded to 
the matrix by ECS. 

The system is designed in a “star” configuration, in which each 
member of the system connects directly to the matrix rather than to 
each other. Audio signals are routed through the central matrix and out 
to the connected audio devices by the matrix under control of the map 
created by ECS.

ECS can also be used to monitor the matrix for faults and log errors to 
a logfile for analysis.  
C
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Figure 1-3: An Eclipse Configuration

Basic Setup Steps
The basic steps for setting up an Eclipse matrix system are:
1. Ensure that there is a working connection between the ECS PC and 

the matrix (see chapter 3 for information on selecting the connection 
type and setting ethernet addresses).

2. Click on the ‘System’ menu to open the systemscreen and right click 
over the systems pane to open the ‘Add Matrix Frame’ option.

3. Click on the ‘Add Matrix Frame’ to add a new matrix.  Click on the 
highlighted ‘Please choose a matrix type’ button to open the matrix 
type menu and select the required matrix type.

4. Click on the ‘New Matrix Frame’ window on the new matrix icon and 
enter the name of the new matrix.

5. Click over the ‘Matrix IP Address’ window of the new matrix icon and 
enter the IP address of the new matrix.

category-5 cable 

talk pathway 

listen pathway 

category-5 cable 

talk pathway 

listen pathway 
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listen pathway 

category-5 cable 

talk pathway 

listen pathway 

Eclipse Matrix  

The matrix system forms a star configuration. 
Audio travels through the central matrix and 
out to the connected panels. The panels
do not connect to each other, but to the matrix. 

Label appears in display
of intercom 

Cat-5 cable connects to rear-panel  
RJ-45 connector, or “port”  
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6. Click on the ‘Hardware’ menu to open it and click on ‘Cards and 
Ports’ to open to hardware configuration screen.

7. Select each MVX-A16 card to display the system ports list and add 
panels and interfaces to the ports (Median and Omega only).

8. Select each E-QUE card fitted and configure the card ports 
according to the type of card configured via the ‘Card Properties’ link 
(median and omega only).

9. Select each IVC-32 card fitted and configure the card for IP 
communication via the ‘Card Properties’ link (median and Omega 
only).

10. Select each LMC-64 card fitted and configure the card for IP 
communication via the ‘Card Properties’ link (Median and Omega 
only).

11. From the ‘Configuration’ menu select ‘Panels’ and configure the 
keys on the panels from the list of sources and destinations.

12. When the panel programming is complete click on the ‘Apply 
changes To System’ link on the system menu to download the map 
to the matrix.

The following sections describe some of the main elements of the 
Eclipse Configuration Software. The subsequent chapters in this 
manual describe these elements in detail.  

Setting Up Matrix Port Functions  
Each physical port on the matrix needs to know what type of remote 
device connects to it. This could be one of the many different types of 
Clear-Com intercom panels, control panels, or interfaces that connect 
the matrix to telephones, 2-way radios, and so on. 

In addition each port needs a name to identify it on intercom panels 
and other connected equipment. Each port has two available labels.

A Talk label identifies a port sending audio to a destination.

A Listen label identifies a port receiving audio from a source.

Figure 1-4: Matrix Port Functions

Port 1 Port 2

Audio Audio

Talk
Label

Listen
Label

The Talk Label is the 
name of the port the 
operator talks to 
(output).

The Listen Label is the 
name of the port the 
operator listens to 
(input).
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Labels can be up to five characters in length (limited by the panel 
display) but in the case of V-Series panels the labels are extended to 
ten character labels by concatenating the Talk and Listen labels.

Assigning Names to Individual Panels    
At individual panels and interfaces port “labels” are assigned to 
specific keys or buttons. If an operator communicates frequently with a 
source or destination in the matrix system a key or button may be 
assigned on a panel for either talking or listening directly to that source 
or destination. 

These individual buttons or keys are similar to “speed dials” on a 
traditional telephone.  Each key can be set up so that when it is 
pressed, it makes an audio route. For example a key on a panel 
attached to port 1 may be programmed to send audio to port 28. When 
that key is pressed, an audio route is activated from the originating 
panel to the device connected to port 28. When the key is released, 
the route is de-activated (these audio routes are also called 
“crosspoints”).

Figure 1-5: Key Assignment

THE MATRIX CONFIGURATION MAP
Full system configurations are created using ECS including port 
functions, talk-and-listen audio routes, control functions and other 
functions. The configurations are then compiled to create maps and 
the maps are downloaded from the PC to the matrix, where they reside 
in operational memory.   At the push of a button on the front panel of 
the matrix, the entire map goes into effect in the matrix system. The 
matrix holds up to four maps in its operational memory. An unlimited 
number of configurations may be stored on the ECS PC or on a server. 

These system configurations are called by various names such as 
“projects”, “configurations” or “maps”.   In this manual, they are called 
“projects” or “configurations”. The following sections describe some of 

Port 1 Port 28

Source Destination
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the types of communications routes that can be created with ECS. 
Subsequent chapters in this manual describe these topics in detail. 

Groups—Party Line and Fixed 
Group communication may be configured in several ways. In a “fixed 
group” configuration an operator speaks to all members of the group at 
once. However, if a group member responds by calling the operator 
back with their answer-back key the audio path goes to operator panel 
only. 

Alternatively, all members of a group can speak with all other members 
of the group at the same time. This is commonly called a “conference” 
or “party line”.   It is similar to a telephone conference call with its 
two-way, full-duplex communication. Members of a party line can join 
and leave in real time, making the membership dynamic in the sense 
that it is always changing. 

Controls—DTMF Sequences, Relays, Routes 
An intercom panel can be used to perform a variety of other functions 
besides sending audio. It can activate a DTMF sequence to call out on 
a telephone line, activate an electronic relay to turn on a light or lock a 
door, or activate audio from an external router like a mixer desk. These 
types of function are called “controls”. 

Call Signals
A “call signal” is an audible or visual signal or ”Tally” sent on an 
intercom channel, with or without accompanying audio. These signals 
have a variety of purposes from alerting an operator who has taken off 
their headset, to activating control sequences.  
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Interruptible Foldback (IFB) 
An audio source such as “on-the-air” or “program” audio can be routed 
through the matrix to a presenters ear pieces.  In a typical broadcast 
application, program audio is routed to the “talent”– a collective term 
for any person in front of the camera broadcasting directly to an 
audience. A director or other audio person can then interrupt or dim the 
program audio to the “talent” for announcements (commands) or cuing 
by using the “interruptible foldback” or IFB feature. 

Figure 1-6: IFB Operation
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GETTING STARTED: 
INSTALLING, 
STARTING, AND 
EXITING ECS 
This manual provides a comprehensive guide to the Eclipse 
Configuration Software (ECS).  ECS controls all system variables, 
operating parameters, and operating configurations for Eclipse 
matrices.  

SYSTEM REQUIREMENTS
ECS requires the following system configuration:

• Microsoft Windows XP Professional SP3 or Windows Server 2003 
SP1 (SP2 recommended) or Windows Vista SP1 or Windows 7 
operating system. 

• Appropriate language support if non-latin fonts are to be used (see 
chapter 5 ‘Setup Eclipse’).

• Microsoft SQL Server Express 2005 service pack 3 (supplied with 
ECS Server, not required for ECS client).

• Microsoft Internet Explorer 6 or better.

• Microsoft .NET Framework 3.5 SP1 (supplied with ECS server, not 
required for ECS client).

• Personal computer with Microsoft Windows Experience Index base 
score of 3.0 or higher when running Windows Vista or equivalent if 
running Windows XP, Windows Server 2003 or Windows 7.

• 1GB RAM or better recommended depending on operating system.

• 10GB of free hard disk space.

• Combo DVD drive.

• SVGA display resolution.

• Mouse or other pointing device.

• Appropriate keyboard if non-latin fonts are to be used.

• One serial port or USB port and USB to serial adaptor (this may not 
be suitable for all applications).

• IEEE 802.3 Ethernet card.

This manual provides a 
comprehensive guide to the 
Eclipse Configuration 
Software. 

2
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INSTALLING ECS
Note: The instructions in this manual are based on Windows XP   

as the operating system on the computer.  
Clear-Com supports the use of the Eclipse Configuration 
Software (ECS) V5.2 on Microsoft's Vista and Windows 7 
operating systems.

Microsoft, Windows XP Professional, Windows Server 2003, 
Windows Vista and Windows 7 are either registered 
trademarks or trademarks of Microsoft Corporation in the 
United States and/or other countries.
All other trademarks are property of their respective 
owners. 

Before Installing ECS
If ECS is being installed as an update to an existing ECS 
installation it is recommended that all the system configurations 
are backed up by exporting them to Clear-Com Configuration files 
(.ccn).  These should be placed in a directory outside the 
directory tree used by the currently installed ECS.  They can also 
be backed up to external media such as CD or DVD.
Ensure that the required Windows service packs are installed 
before installing ECS V5.2 (see “System Requirements” on 
page 2-1).  Windows XP Service Pack 3, Windows Server 2003 
Service Pack 2 and Windows Vista Service Pack 1 are supplied on 
the system software DVD and should be installed as required 
before installing ECS.
To export the system configuration or project it should be opened and 
then exported by opening the ‘File’ menu and selecting the ‘Export 
Project’ option.  The directory and filename can then be selected.

In a networked system all the matrices must be upgraded to V5.2 as 
matrices running V5.2 cannot be networked with matrices running 
earlier versions of software such as V5.1, V5.0 or V4.2.

Updating an Existing ECS Installation
If the ECS install is to update an existing ECS installation the user 
should read the chapter ‘’Eclipse System Software Upgrades’ before 
commencing the installation.

To install ECS
Ensure that the installer has full Administrator rights as these are 
required in order to install ECS.
1. Insert the installation DVD into the computer’s DVD drive. 
2. The ECS installation media should autostart and display the 

installation instructions on a browser page.
If the installation page is not displayed locate the “autorun.exe” file 
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on the distribution media and double-click it to display the 
installation instructions.

3. Click on the “Eclipse Configuration System” link to start the ECS 
install.

4. Follow the instructions on the screen to install the program.
5. When the installation is complete, a message appears on the screen 

to verify that the program has been successfully installed on the 
computer. Click on the ‘Finish’ button.

The Eclipse Configuration Software is now installed on the computer.  

Note: If Windows XP Service Pack 3 is the installed on the  
computer, ECS automatically configures the firewall 
settings. If Windows XP Service Pack 3 is not installed on 
the computer the installer will stop and display a message 
indicating that the user must install Service Pack 3 before 
rerunning the ECS installer. 
If the computer is running Windows Server 2003 then Server 
2003 Service Pack 1 must be installed prior to installing ECS 
(Service Pack 2 is recommended).  If Windows Server 2003 
Service Pack 1 is not installed on the computer the installer 
will stop and display a message indicating that the user 
must install Service Pack 1 or 2 before rerunning the ECS 
installer. 
If the computer is running Windows Vista then Vista Service 
Pack 1 must be installed prior to installing ECS.  If Windows 
Vista Service Pack 1 is not installed on the computer the 
installer will stop and display a message indicating that the 
user must install Service Pack 1 before rerunning the ECS 
installer. 

In some cases the ‘Add ECS to Firewall’ dialog box may be displayed 
with one of the following messages: 

• If the firewall configuration is successful, “Updated XP Firewall” 
appears in the dialog box when running Windows XP.  

• If the firewall configuration is not successful a message will be 
displayed in the dialog box referring the user to more information. 

• The Windows operating system may show a Firewall dialogue box 
asking whether to Block or Unblock ECS.  Select Unblock ECS.
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RUNNING ECS
LOGGING IN TO ECS
To start the program, click ‘Start’, then ‘Programs’, then ‘Clear-Com’, 
then ‘Eclipse Configuration Software 5.2’ and then ‘Eclipse 
Configuration Software 5.2’. 

Alternatively, click the Clear-Com ECS V5.2 shortcut on the desktop 
and the ECS user login screen will be displayed.  If ECS is to be used 
in Local mode (running entirely on the local PC) the user can log in 
immediately.  If ECS is to be used in Client Server mode (see chapter 
10) the options button should be selected to allow the remote server to 
be selected (see “Client Server Login” below).

Figure 2-1: ECS Login Screen

The “Username” and “Password” fields are already populated with the 
default entries: 

• The default Username is: EclipseUser 

• The default Password is: EclipseUser

Note:  The fields are not case sensitive. 

If required enter a different ECS username and password and click on 
‘OK’ to log in.  If the username or password is invalid an error message 
will be displayed.  If ECS is being used for the first time only the default 
username and password will be valid.

Once logged in to ECS the User Management facility can be used to 
change the password for the default user and add further users.  This 
is described in chapter 3 of this manual.

Note: The default user has ECS administrator privilege.

Once logged in ECS will display an empty screen until the user selects 
and loads a configuration or creates a new configuration.
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Client Server Login
When running in a client/server environment (see chapter 11 for 
details) the user should not log in using the default localhost server 
(http://localhost/EclipseServer/) but log in to the required server PC.  
To do this click on the ‘Options’ button to display the name of the ECS 
server.

Figure 2-2: ECS Logon Server Option

If ECS is to be run in client/server mode a license key is required to 
enable this facility.  The user should contact the equipment distributor 
for further information.

If running in client/server mode edit the ‘Log on to’ box to the name of 
the server or use the drop-down list to select a server then log in as 
normal e.g. http://myserver/Eclipseserver/.  If the client/server license 
key has not already been input the license key will be requested.

Figure 2-3: Client/Server License Key Request

Enter the license key as supplied and click on the ‘OK’ button.  The 
client/server facility will then be enabled.  ECS login will not request the 
license key again once it has been successfully entered.

If a valid license key has not be input an error message will be 
displayed and the user will not be able to login in client/server mode.
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Figure 2-4: License Error Display

If the client and server ECS versions are different an error message is 
display indicating that incompatible versions of ECS are in use.

Figure 2-5: Incompatible Client/Server Software Error

If this error is displayed the user should select ‘No’ and not try to log in 
to the server until the problem has been resolved.  The ‘Yes’ option is 
only provided for use by system engineers.  The system administrator 
should ensure ECS on the server and all the clients have been 
updated to the same version.

After logging in either locally or to a server the ECS initial screen is 
displayed.
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Figure 2-6: ECS Initial Screen

ABOUT ECS
The version of ECS can be displayed by opening the Help menu on the 
Windows toolbar and selecting ‘About’.

Figure 2-7: ECS About Screen
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The version of ECS is displayed along with version information relating 
to matrix programming (Logic Maestro and Macro Editor) and  
client-server functionality.

Logic Maestro
The Logic Maestro is a built-in ECS function that allows the matrix 
functions to be programmed via a visual logic design interface.  This 
visual interface allows the required logical operations to be created by 
dragging and dropping symbols for various logical operations and 
connecting them together to create the required functions.  This 
interface creates the underlying control macros that are used to 
program the matrix.  This facility is described in the Logic Maestro 
manual (part 810414Z).  The Logic Maestro option requires an 
additional license.

Macro Editor
The Macro Editor is a built-in ECS function that allows the matrix 
functions to be programmed directly via a macro language.  This 
facility is described in the Logic Maestro manual (part 810414Z).  
Macro Editor is included with the Logic Maestro license.

Single DB mode
This may be set to True or False, depending on whether ECS is 
operating in Local mode or Client Server mode and reflects whether 
ECS is using a single local database (Local mode) or a remote 
database and a local database (Client Server mode).  

• True - ECS is operating in Local mode and only using a single local 
database.  When a configuration is opened the configuration data 
is copied from the local database to a temporary file for editing.  It 
is copied back to the database when the configuration is closed if 
the user selects ‘Yes’ to the ”Save Changes” dialogue.

• False - ECS is operating in Client Server mode using a local and 
remote database.  When a configuration is opened the data is 
copied from the remote database to the local database for editing.  
It is copied back to the remote database when the configuration is 
closed if the user selects ‘Yes’ to the ”Save Changes” dialogue or 
does a map download.

Localhost mode
This may be set to True or False depending on whether ECS is 
running entirely on the local PC or over a network with the software on 
a remote PC being accessed via web services and SOAP (Service 
Oriented Architecture Protocol).  Normally this mode implies Client 
Server operation and that the user has logged in to ECS specifying a 
different PC using the server option.  It is possible to treat the local PC 
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as both the client and the server by specifying the local PC as the 
server but this is not recommended use.

• True - ECS is running only the local PC with the user having logged in 
as a local user.

• False - ECS is running in Client Server mode and accessing the 
software functions over the network

ECS Help
Selecting the ‘How Do I’ entry (F1) on the Help menu displays basic 
help about ECS functions.

EXITING ECS
To exit the ECS program open the File menu (Alt-F) and select Exit.   
The user will be offered the option to save any configurations that are 
currently open.

 

Figure 2-8: Configuration File Close

To save the configuration click on the ‘Yes’ button; to abandon any 
unsaved changes click on the ‘No’ button.  

If any changes have been made to the configuration that should be 
applied to the system click on the ‘Apply changes to Frame’ command 
on the command line before closing the configuration file.

See the chapter 11 in this manual on Eclipse Downloads for more 
information. 

When the configuration is closed the user menus will also be closed.

To log out of ECS open the File menu and  select the ‘Log Out’ 
command.  All the menus will be closed and the ECS command line 
greyed out.  

To log back in open the File menu and click on ‘Log In’ to display the 
login dialogue as described previously.  
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SETTING UP A 
SYSTEM
INTRODUCTION
The following steps will need to be completed to set up a new Omega 
or Median matrix.  For information on setting the default IP address on 
Eclipse-32 and Eclipse Pico matrices please refer to the respective 
hardware manuals.

• Reset the matrix to the factory default IP address (169.254.0.100).  
This is a link local IP address which means that a PC connected 
directly to the matrix using an ethernet cable, but in DHCP mode, will 
be able to the communicate with the rack.  When the rack's IP 
configuration is defaulted back to the above link local address it also 
defaults to DHCP enabled.

•  The reset sequence for Omega and Median matrices is:

• Remove the slave CPU card (if present).

• Press and hold the ‘ENG’ and ‘FULL RESET’ front panel buttons 
simultaneously then press the ‘RESET’ button (see illustration) on 
the master CPU card.

• Replace the slave CPU card if there is one otherwise the 
procedure is complete.

• Remove the master CPU card

• Press and hold the ‘ENG’ and ‘FULL RESET’ front panel buttons 
simultaneously then press the ‘RESET’ button (see illustration) on 
the slave CPU card.

• Replace the master CPU card

• Ensure that the matrix and the ECS PC are connected using 
ethernet, either directly or via a network (direct connection from PC to 
Matrix will require a crossover ethernet cable).

• Configure ethernet on the ECS PC.

• Create a configuration with the factory default IP address.

• Download the complete configuration map to the matrix via ethernet 
using the factory default IP address.

A more detailed sequence of actions for the initial configuration are 
given in the section “Initial Configuration Sequence” on page 3-7.

3
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MATRIX ETHERNET OPERATION
The Omega and Median CPU card ethernet ports are normally 
connected to a LAN and used to communicate with clients such as 
ECS and Production Maestro.  The ethernet port functionality depends 
on the IP address setup.

If an IP address of 0.0.0.0 is configured on the second ethernet port, it 
will not be used for Tx or Rx.  This is the default setup if the default IP 
address is set as described above.

All matrix to matrix traffic is sent out on both ethernet ports. This 
applies to both directed and broadcast packets.  All matrix to matrix 
traffic is also received on both ethernet ports. If the traffic is transaction 
related, the second (duplicate) message received is not consumed, but 
simply dropped. 

The matrices listen for client connections on both ethernet ports. Once 
the connection is made it is added to the list of connections to service. 
Broadcast type Tx data is duplicated out on each connection e.g. HCI 
connection to the matrix from 3rd party applications. 

The ECS Server makes a connection on either the main or backup 
ethernet port of each system in the linked set. If both are up, this will 
default to the primary port. In the event that connection is lost to the 
currently active port on a matrix the ECS server will swap over to using 
the other ethernet port.  If this connection is lost only on one matrix in a 
linked set, the others will not be affected. 

Configuration Restrictions
The network ID on the first ethernet port must be different to that of the 
second port.  The network ID is defined by the IP address and the 
network mask for the port.  For example a network address of 
172.16.2.1 and a mask of 255.255.0.0 gives a network ID of 172.16.  
Therefore in this scheme the second port could not have an IP address 
starting with 172.16.  If the network mask is extended to 255.255.255.0 
the network ID becomes 172.16.2 so the second port could have an 
address of 172.16.3.1  and a mask of 255.255.255.0 giving a network 
ID of 172.16.3 for the second port.  

If both ethernet ports are set up with the same network ID this 
condition results in data loss on one or both of the ethernet ports. 

Ethernet redundancy and the use of a default gateway is not 
recommended.  An IP address and gateway combination on an 
ethernet port means that all Tx traffic to any address is possible on the 
port.  Traffic that actually matches the other ethernet port can therefore 
be sent out on the wrong port. 
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SELECTING SERIAL OR ETHERNET CON-
NECTION 
ECS can communicate with a matrix using one of the following two 
methods:  

• Ethernet connection  

• Serial connection if the ECS PC is connected directly to the matrix via 
an RS-232 cable.  

Ethernet is the preferred connection type for all applications.  

Note: The factory ships an Eclipse matrix without an assigned IP 
address. Therefore in order to use Ethernet the IP address 
must be reset to the default.  The system can then be 
configured for an Ethernet connection. 
It is not possible to change the IP address via a map 
download; it must be done from the System screen or the 
Matrix Event Log (see the chapter on Diagnostic Tools for 
details on the Matrix Event Log).

SERIAL CONNECTION 
To establish a serial connection between the ECS PC and the matrix 
the hardware must be connected first and then the software 
configured. 

• To establish the hardware connection, connect a serial (RS-232) 
cable between the computer's serial port and the connector labelled 
"RS-232" on the rear of the Eclipse frame.

• To configure the ECS  software for serial communication, follow the 
procedure below.  

To set up a serial connection between ECS and the Eclipse frame: 
1. From the ECS command line open the ‘File’ menu and select ‘Matrix 

Connection’.
The ‘Connection Settings’ dialog box appears. Because ethernet 
connection is the default, it is already selected. 

2. From the drop-down menu select the PC’s COM port the serial cable 
is connected to.  
Clicking on ‘Only Show Available Ports’ causes the drop-down box 
to only display the available COM ports on the computer.  

Make a small configuration 
map with the required IP 
address and download it 
using the serial link then 
switch to ethernet mode to 
complete the configuration

PC Matrix

RS232
Link
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Figure 3-1: Selecting a Serial or Ethernet Connection 

Note: If the matrix connection type is changed between ethernet 
and serial whilst a user is logged in (ECS in client/server 
mode) the user will be logged out.  The user will need to log 
back in via the File menu to resume ECS operations.

ETHERNET CONNECTION 
To establish the hardware connection on a network, an Ethernet 
crossover cable should be connected from the LAN connection on the 
PC to the LAN1 connector on the rear of the Eclipse frame. Otherwise 
straight-through CAT5 cables can be used via a Switch.

Note: Where a linked set of matrices has been configured 
ethernet switches rather than hubs should be used to 
connect system components.

To establish communication between the PC and the Eclipse frame, 
the PC and the frame must be on the same subnet. Therefore the PC 
Administrator must set the IP address of the computer to the same 
subnet as the Eclipse matrix. Windows provides many different 
methods of reconfiguring network settings. The following is one 
method: 

1. From the Windows ‘Start’ menu, select ‘My Network Places’.  
2. From the ‘Network’ task pane, click ‘View Network Connections’.  

The ‘Network Connections’ dialog box appears. 

Ethernet mode to complete 
the configuration.

PC Matrix
Crossover

cable

Lan1

PC Matrix

10/100
SwitchStraight

CAT5
Straight
CAT5
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Figure 3-2: The Network Connections Dialog Box

3. Click on the ‘Local Area Connection’ icon once to highlight it, then 
right-click the icon for a shortcut menu.    

4. From the shortcut menu, select ‘Properties’. 
The ‘Local Area Connection Properties’ dialog box appears.
   

Figure 3-3: Local Area Connection Properties Dialog Box
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5. Click the ‘Internet Protocol (TCP/IP)’ icon to highlight it, then click 
the ‘Properties’ button. 
The ‘Internet Protocol (TCP/IP) Properties’ dialog box appears, as 
shown in Figure 3-4 . 
 

Figure 3-4: Internet Protocol Properties Dialog Box

6.  Click Use the ‘Following IP Address’, then enter an IP address of 
169.254.0.10. The subnet mask should be 255.255.0.0. Ensure that 
all other settings are blank. Select OK, then OK again.  

The IP address of the computer is now set to the same subnet as the 
Eclipse matrix.

Checking Connections with the Windows Ping Util-
ity 
If there is a problem connecting to the Eclipse matrix a Windows utility 
called “Ping” can be used to verify that the cabling and IP settings are 
correct. 

To use the Windows “Ping” utility
1. From the Windows ‘Start’ menu, select ‘Run’. 

The ‘Run’ dialog box appears. 
2. Type “cmd” in the Open field and click OK. 

A command window opens. 
3. Type ‘ping xxx.xxx.xx.xxx’ where the x’s form the IP address of the 

Eclipse matrix. 
4. Press ‘Enter’. 
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If the ping was successful a reply will be received. If the ping was not 
successful check the cabling and IP settings. 

Note: Ensure that Network Bridging and any firewalls are 
disabled. 

INITIAL CONFIGURATION SEQUENCE
The initial configuration sequence for a matrix that has no map loaded 
is described in the following section.  Later sections provide more 
details of the required operations.
1. Reset the matrix to the factory default IP address (169.254.0.100).  

The reset sequence is:
• Remove the slave CPU card

• Press and hold the ‘ENG’ and ‘FULL RESET’ front panel buttons 
simultaneously then press the ‘RESET’ button on the master CPU 
card.

• Replace the slave CPU card

• Remove the master CPU card

• Press and hold the ‘ENG’ and ‘FULL RESET’ front panel buttons 
simultaneously then press the ‘RESET’ button on the slave CPU 
card.

• Replace the master CPU card

2. Log in to ECS using an account with Admin rights.
3. Open the ‘File’ menu and click on ‘Matrix Connection’ to display the 

matrix connection setup.
4. Set the matrix connection to Ethernet (click on the ‘Ethernet’ radio 

button and then click on the ‘OK’ button).
5. Create a new configuration file for the matrix using the ‘File’ and 

then ‘New Project’.
6. Enter the configuration name and description.
7. The IP address of the new configuration will be set to the factory 

default (169.254.0.100) initially.
8. Select ‘System’ from the ECS menu.
9. Ensure the hardware type is set correctly then right click on the 

matrix icon to open the matrix options.  Select ‘Configuration’ and 
then ‘Create Configuration Discover Hardware’.

10. ECS will then communicate with the matrix to obtain a list of all the 
hardware connected to the matrix.

11. Complete the matrix configuration (see the chapter “Setup 
Eclipse”).

12. Download the completed configuration to the matrix by clicking on 
“Apply Changes” link on the matrix options and selecting the 
required options from the dialogue (see the chapter on “Eclipse 
Downloads”).

Details of some of the operations are given in the following sections.
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CREATING A CONFIGURATION FILE 
The first step in setting up a system is to create a configuration file. At 
first this file will not have any content. Eventually the configuration will 
be populated with all of the details of the system, including the panels, 
interfaces, and control devices assigned to ports on the matrix, and the 
alphanumeric names, or "labels", assigned to each device. 

To create a configuration file:
Open the File menu and select ‘New Project’ (Ctrl-N).

Note: The Alt-F, N and Ctrl-N commands can be used when in any 
ECS mode to start a new configuration map.

The ‘Create a New Configuration’ dialog box appears, as shown below. 

Figure 3-5: Create a New Configuration Dialog Box

Note: If a configuration has already been populated or 
downloaded select Open and select the already existing 
configuration file from the dialog box (see chapter 5).

Type a name and description for the configuration and click ‘Save’.

The name of the configuration appears on the status line at the bottom 
of the screen. Note that the name of the matrix frame does not yet 
appear. 
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SETTING UP A NEW MATRIX
Once a new project has been created matrices can be added to the 
project in two ways; either by adding matrices that have been 
discovered by ECS or by creating new matrices.

Figure 3-6: Blank Matrix Screen

Click on the Matrix IP Address box to edit the default address 
displayed then click on the ‘Configuration Manager’ button to open the 
project configuration setup.

ADDING A DISCOVERED MATRIX
This approach assumes that the matrix or matrices has an ethernet 
address set up that is accessible to the ECS PC (see “Ethernet 
Connection” on page 3-4).

1. Open the ‘System’ menu.

The systems screen is displayed.  If there are active matrices on the 
network ECS will discover them and display a list of these matrices 
in the centre of the screen.
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Figure 3-7: System Screen

2. Click on ‘Add Matrix to System’ on one of the matrices displayed to 
add it to the new project.  An options screen will be display allowing 
the user to discover the matrix and panels, create a blank 
configuration or upload a configuration.

Figure 3-8: Add New Frame Dialog

Discover Hardware and Panels
This option is the simplest means of adding a new matrix to a system 
as it will fully populate the project with the cards and panels without the 
user having to add them all manually.

The first step in setting up a 
system is to create or select 
a configuration file. 
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Click on the radio button and then select “OK” to discover the 
hardware.  A progress bar will be displayed while ECS communicates 
with the matrix.

Figure 3-9: Matrix Hardware Detect

Once the hardware has been detected the matrix will be added to the 
project in the system pane and the Hardware, Configuration and 
Diagnostic menu links will be displayed in the menu pane.

The matrix IP address and system preferences can then be set up as 
described below.

Create Blank Configuration
If this option is selected the frame is added and the Hardware, 
Configuration and Diagnostic menu links are displayed in the menu 
pane.  However no cards or panels are configured and the Hardware 
link will be flash orange to indicate there is no hardware configuration.

The matrix IP address and system preferences are set up as described 
below, after which the Hardware should be configured manually.

Upload Configuration from Frame
The option requires that the matrix to be added to the new project 
already has a configuration loaded.  If this is the case it is the quickest 
way to set up a frame as the configuration would include the system 
and panel setups as well as cards and panels present.

Select the option to upload the configuration and click on the “OK” 
button.  The IP address of the discovered frame will be displayed and 
confirmation of the upload requested.

Figure 3-10: Upload Confirmation
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To continue click on ‘Upload’ and ECS will upload the current 
configuration.

Once the configuration has been loaded the Hardware, Configuration 
and Diagnostics menu links will be displayed and the configuration can 
be edited.

Creating a New Matrix
As well as adding a discovered matrix to the project it is also possible 
to add a new matrix directly.

Position the mouse pointer over the system pane and right-click to 
open a menu.

Right click in the systems pane to open the ‘Add Matrix Frame’ prompt 
and click on it.

Figure 3-11: Creating a New Matrix

Once the new matrix has been added it should be configured as 
described in “Configuring a New Matrix” below.

Configuring a New Matrix
After a new matrix has been added to the system pane it will need to 
be configured before cards and panels can be added.

Figure 3-12: New Matrix Icon
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The first step is to define the matrix type.  Click on the ‘Please choose 
a matrix type’ link on the new matrix symbol to open a list of available 
matrix types and select the required matrix.

Figure 3-13: Select Matrix Type

Click on the required matrix type and the menu will close.  The 
selected matrix type will be added to the configuration.

Figure 3-14: Matrix Type Configured

The next step is to click on ‘New Configuration’ to open the matrix 
configuration menu.
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Figure 3-15: Select IP Settings

Click on ‘Change IP Settings’ to enter or amend the IP address for the 
frame.
An IP address uniquely identifies each computer or device on a 
network that uses TCP/IP protocols. Note that in ECS an IP address is 
required for all matrix map configurations, regardless of whether the 
computer on which ECS is installed is connected to a Ethernet network 
or is connected serially.

Figure 3-16: Matrix IP Settings

To enable changes to the IP settings click on the ‘Edit’ button.
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Figure 3-17: Edit IP Settings

If a DHCP server is to be used click on the ‘DHCP Enabled’ checkbox 
to obtain all IP settings automatically.  The other boxes will be greyed 
to indicate that they cannot be altered.

If DHCP is not to be used edit the parameters in the boxes as required.

Click  on the tick button to save the amended settings.   A warning 
message will be displayed.  Click on the ‘OK’ button to confirm the 
changes.
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